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1. Introduction 
 

STIPumpCard™ is powerful and user-friendly software for simulating the dynamic behavior 

of pumpjacks for a wide range of wells. STIPumpCard can simulate both vertical and 

deviated wells and predict the load at the plunger from a surface card as well as side forces 

in deviated wells and wells with long horizontal sections. STIPumpCard has been validated 

with data from instrumented wells and can model wells over 10,000 ft in length as well as 

phenomena such as fluid pound, gas interference, and gas locking. 

In addition to being accurate and reliable, under a wide range of conditions, STIPumpCard 

has some unique features not found in other industry software such as allowing a user to 

specify different upstroke and downstroke rates. 

STIPumpCard produces a number of plots, including dynamometer cards, fatigue life, 

compressive load distribution, speed reducer torque and rod side forces. STIPumpCard also 

predicts other parameters such as the minimum required motor power and required speed 

reducer torque rating.  

STIPumpCard supports six types of units; Conventional, Mark II, Air Balanced, Reverse Mark 

(Torque Master), Hydraulic, and Rotaflex. 

STIPumpCard can be run in batch processing mode, which allows multiple simulations to be 

executed sequentially. This feature is especially useful for long runs, such as for deviated 

wells, where contact and frictional forces are calculated using a proprietary finite element 

model, developed for DSD, our rotary drilling dynamics and torque and drag software. 

STIPumpCard contains conversions and calculators which aid in the calculation of input 

parameters, which include: 

• Unit conversion 

• Density conversion 

• Pump intake pressure calculator 

• Stroke rate calculator 

• Free gas calculator 

• Damping factor estimator 

• Pump volumetric efficiency (slippage)  
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1.1. Main User Interface 

 

Figure 1 - Main User Interface 

The following is a description of pulldown menus in the user interface. 

1. Menu Bar:   

• File  

o New:  Create a new project 

o Open:  Open a previously saved project 

o Save:  Save the current project  

o Save As:  Save the current project to a new location 

o License:  Open License Manager 

• Run  

o Run:  Run the simulation 

o Batch Process:  Navigate to the batch processing tab 

o Estimate Production: Produces a quick estimate of fluid production 

without running the simulation. This calculation does not account for 

gas interference. 

• View 

o Project Folder:  Opens the project folder in Windows Explorer 

o Output Folder:  Opens the output folder in Windows Explorer 

o Close all Figures:  Close all open plots, tables, and figures 
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o Overlay DYN file: Plot the dynamometer card from a DYN file along 

with the simulated dynamometer card produced by STIPumpCard 

• Settings 

o Make Current Entries the New Default Values:  Make current user 

inputs, the default startup settings for a new project 

o Restore Default Entries:  Restore original default settings 

• Help 

o Help:  Open the User Guide 

2. Quick Access Bar:   

•  New:  Create a new project 

•  Open:  Open a previously saved project 

•  Save:  Save the current project  

•  Run:  Run the simulation 

•  Output Folder:  Open the output folder in Windows Explorer 

•  Help:  Open the User Guide 

3. Input Tab: Contains all required input data and selections to run a simulation. This 

tab contains the following sub-tabs: 

• Input Parameters: Well, tubing and fluid parameters. See Section 2. 

• Rod Properties: Rod dimensions and material properties. See Section 3. 

• Surface Unit: Surface unit types, sizing, and stroke rate. See Section 4. 

• Deviated Well: Deviated well survey information and friction coefficient. See 

Section 5. 

• Solver Parameter: Allows the user to control simulation accuracy and speed. 

See Section 6. 

4. Output: Buttons to display output plots and tables See Section 7. 

5. Tools: Provides the user with calculation and conversion tools. Section 8. 

• Unit Conversion: Convert between a wide range of units. See Section 8.1. 

• Density Calculator: Convert between density units. See section 8.2. 

• Intake Pressure Calculator: Estimate Pump Intake Pressure (PIP) from fluid 

level and casing pressure or IPR data. See section 8.3. 

• Stroke Rate Calculator: Estimate the stroke rate required to achieve a target 

production. See section 8.4. 

• Free Gas Calculator: Estimate the fraction of free gas present in the plunger. 

See Section 8.5. 

• Damping Factor Calculator: Estimate the damping coefficient based on 

stroke rate and Surface Stroke Length. See Section 8.6. 

• Pump Efficiency Calculator: Estimate the pump volumetric efficiency. See 

Section 8.7. 

6. Batch Processing: Used to run multiple simulations consecutively (batch 

processing). See section 9.  
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2. Input Parameters 

 

 

Figure 2 - Input Parameters Panel 

2.1. Search Bar 

 

Figure 3 - Input Parameters Panel 

The search bar is located just below the Input tab. A user can type in keywords to find 
corresponding inputs in the GUI. The search functionality will search within the input tab. 
(Search doesn’t include tools tab or the output tab) 

 

2.2. Project 

 

Figure 4 - Project Path Display 

The project is the path to the file where all project settings and parameters are saved. A user 
can navigate to this directory from the Menu bar View → Output Folder 
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2.3. Simulation Settings GroupBox 
Select simulation mode (Vertical Well, Deviated Well or Pump Load Analysis) and the 

number of strokes.  

Simulate Number of Strokes: the number of cycles to simulate. STIPumpCard™ simulates 

the dynamic behavior of the sucker rod starting at rest. It is, therefore, recommended to 

simulate at least two strokes for the rod to approach steady-state behavior. Simulating a 

large number of strokes may be unnecessary and will increase run time. 

The three Simulation Modes in STIPumpCard are: 

• Vertical Well: Simulates vertical wells  

• Deviated Well: Simulates deviated wells by accounting for contact friction between 

the rod and tubing.  

• Pump Load Analysis: Calculates load at the pump based on the load at the surface.  

2.4. Pump Load Analysis 
This group box is enabled when the user selects "Pump Load Analysis" as the Simulation 

Mode.  

There are two ways of inputting a surface dynamometer card; one is by via a DYN File 

(generated by programs such as TAM™ or RODSTAR™), and the other is by via a Surface 

Load File.  Additional inputs include: 

• Specific Gravity for Oil, Water and Gas (Input → Input Parameters) 

• Water Cut (Input → Input Parameters) 

• Damping Factor (Input → Input Parameters) 

• Stroke Rate (Input → Surface Unit, this input is not required if a DYN file is used) 

• Rod Dimensions and material properties (Input → Rod Properties) 

 

If a DYN file is used to perform the pump load analysis, the surface unit must be a beam 

balanced unit. If the surface displacement of the polished rod is not purely sinusoidal (such 

as with a hydraulic unit), incorrect outputs will be produced. If instead, a Surface Load File 

is provided to define the dynamometer card, correct output will be produced for any type of 

surface unit. 

Surface Load File is a 3-column, comma-delimited text file, which includes the rod surface 

Time/Displacement/Load information. The units for Time, Displacement and Load should 

be in (seconds), (inches) and (pounds) respectively. Time increments must be monotonic. 

They should be reasonably small, to produce an accurate pump load estimate. Though not 

used, one header line is expected. Figure 5 shows a sample input file for the pump load 

analysis. 
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Time(s),Displacement(in),Load(lbf) 

0,141.5559598,17024.53563 

0.1,146.9631956,16622.07724 

0.2,151.9146617,15961.56614 

0.3,156.3219355,15272.84255 

... 

Figure 5 - Pump Load Analysis File Format 

2.5. Input Parameters 

 

2.5.1. Pump Properties 
 

 

Figure 6 – Pump Properties Panel 
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• Plunger Barrel Clearance: The clearance between the plunger and the barrel, 

defined as:  

Clearance = (Barrel Diameter – Plunger Diameter)/2 

• Plunger Diameter: Diameter of the plunger 

• Plunger Length: Length of the plunger 

• Pump Intake Pressure: Pressure at pump intake, in PSIG. Pump Intake Pressure can 

be estimated using the Intake Pressure Calculator under the Tools, using either IPR 

data or fluid level and casing pressure. 

• Pump Friction: Friction at the pump, applied at the bottom of the rod string 

• Pump Volumetric Efficiency (%):  There is a loss of production due to slippage and 

leakage. Pump volumetric efficiency (%) can be estimated using the Pump Efficiency 

Calculator under the Tools. 

• TV ID: Inner diameter of the traveling valve 

• Valve Spacing: Defined in Figure 7 

 

 

Figure 7 - Valve Spacing Explanation 
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2.5.2. Tubing Properties 
 

 

Figure 8 – Tubing Properties Panel 

 

• Tubing OD: Outer diameter of the tubing 

• Tubing ID: Inner diameter of the tubing 

• Tubing Pressure: Pressure in the tubing at the surface, in PSIG 

• Stuffing Box Friction: Friction at the stuffing box, applied at the top of the rod string 

• Tubing Anchored: tubing is anchored at the bottom hole if this box is checked and 

consequently, the tubing will not be stretched when the standing valve is closed. 

• Tubing Anchor Depth: The measured depth of the tubing anchor 
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2.5.3. Material Properties 
 

 

Figure 9 – Material Properties Panel 

 

• Fluid Temperature: Temperature of the well fluid 

• Fluid Viscosity: Dynamic viscosity of liquid in cp 

• Free Gas Fraction: the fractional (ranging between 0 and 1) amount of free gas 

presented in the plunger at pump intake pressure. The free gas fraction can be 

estimated using the Free Gas Calculator under the Tools. 

• Gas Specific Gravity: Specific gravity of gas in the well 

• Oil Specific Gravity: Specific gravity of oil in the well 

• Water Specific Gravity: Specific gravity of water in the well 

• Water Cut: Ratio of water with respect to the total volume of fluid 

• Service Factor: Depending on the well operating environment, the value is usually 

between 0.4 and 1. 

• Simulate with fluid inertia: Only available at full pump condition (free gas fraction 

equals to zero), when selected, STIPumpCard will simulate the fluid inertia effects 

using the fluid compressibility index  
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• Fluid Compressibility Index: Index indicating how compressible the fluid is, the 

greater this index, the more compressible the fluid is. For water at 1500 PSI, the 

compressibility index is approximately 3. This index can be calculated using the fluid 

compressibility calculator under the Tools tab. 

• Specify different upstroke/downstroke Damping Factor: Damping factors can be 

different for upstroke and downstroke. Check this checkbox to specify a different 

damping factor for the upstroke and downstroke. 

• Damping Factor: Rod damping factor (dimensionless coefficient). Generally, 0.1-0.2 

is used for most wells, however higher damping factors should be considered when 

guides are installed (more fluid turbulence and friction), especially in high volume 

pumping with low gravity oil. Can be estimated based on stroke rate using the 

Damping Factor Calculator under the Tools. Damping factors can be specified 

separately for upstrokes and downstrokes when the checkbox Specify different 

upstroke/downstroke Damping Factor is checked. 

• Gravitational Acceleration: acceleration of gravity on earth, which can vary slightly 

depending on the location and depth. This parameter is included as an input to allow 

the comparison between the results of STIPumpCard and other software on the 

market, which may use a hard-coded and/or different value. 
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3. Rod Properties Tab 
Used for specifying rod grade, minimum and maximum tensile strength, segment length, 

diameter, and grade. Rod taper lengths can be defined by the user or optimized through 

optimization. If optimization is used, a taper length is determined such that the maximum 

Goodman stress in each taper section is similar 

 

Figure 10 - Rod properties Tab 

 

3.1. Material Properties Table 

 

Figure 11 - Material Properties Table 
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The material properties table is used to specify tensile strengths for different grades of 
material. STIPumpCard comes with the following grades: K, C, D, KD, and SB (Sinker Bar). 
More grades can be added to the table using the +/- button or click on the "Read From File" 
button to add grades from a comma delimited text file; an example is shown below. The 
header line (first line in the file) must be present but is not used. The data is assumed to be 
in the units shown in the materials properties table. In the case of metric units, tensile 
strengths are presumed to be in MPa.  

The last column of this table is material type, which can either be HS (high strength steel) or 
Reg (regular). 

 

Grade,Min Tensile Strength (PSI),Max Tensile Strength(PSI),Type 

N97,140000,150000, HS 

D,115000,140000, Reg  

Figure 12 - Material Properties File Format 

 

3.2. Rod Properties Table 

 

Figure 13 - Rod Properties Table 

The Rod Properties table specifies segment dimensions, grade, and material. The rod is 
defined with segments from top to bottom. The first column represents the length of each 
segment, the second column represents the diameter, and the third column is the material 
grade (Note that the grade specified in this table must be listed in the materials property table). 
A blank entry or S in the last column indicates steel. F is entered to indicate fiberglass. 
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A preview is shown to the right of the tables once rod properties have been specified. If a 

preview is not shown, one or more dimensions have not been specified correctly. 

Sinker bars can be added just like any other section of the rod, by providing the diameter and 
the length of the sinker bars. 

 

3.2.1. Create Rod String Using API Number  
Instead of manually filling in the Rod Properties table, a user can also define the rod 

string using API Rod Numbers. Click on the Create Rod String Using API Number 

button below the Rod Properties Table as shown in Figure 13. A dialog will pop up, as 

shown in Figure 14.

 

Figure 14 - Create Rod String Dialog 

The Rod Properties table will be automatically populated using API guidelines, upon 

clicking on the Confirm button. 

3.2.2. Create Rod String Through Optimization  

 

Figure 15 – Rod String Optimization Parameters 

Rod taper sections can also be automatically optimized. STIPumpCard optimization will 

minimize the differences between the maximum stresses for each taper section (excluding 

the sinker bar). Click on the Obtain Optimal Taper checkbox as shown in Figure 15 to 

optimize rod tapers. The optimization assumes that the rod string consists of only steel rods 

and that there are a maximum of three tapers. 

 

Rod taper lengths are optimized using Genetic Algorithm, the optimization parameters can 

be changed by modifying GaSettings.ini in the installation directory 
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4. Surface Unit 

4.1. Surface Unit Types 
STIPumpCard can model six types of units. They are Conventional, Mark II, Air Balanced, 

Reverse Mark (Torque Master), Hydraulic, and Rotaflex Units,  

Dimensions of beam balanced units, including Conventional, Mark II, Air Balanced, Reverse 

Mark (Torque Master), are defined as follows, note that:  

K = √I2 +  (H − G)2 

Conventional Unit Mark II Unit  

  
Air Balanced Unit Reverse Mark Unit (Torque Master) 

  

Figure 16 - Beam Balanced Unit Types 

For the Air Balanced Unit, the user needs to specify parameters such as M, S, Pmax, and 

Pmin. M and S are geometrical and pressure constants supplied by the manufacturer.  Pmax 

and Pmin are the maximum and minimum pressures in the cylinder during operation. 
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Figure 17 - Hydraulic Unit 

Hydraulic Units, such as the one shown above, do not require unit geometry inputs. The 

user defines a velocity profile of the polished rod, based on the maximum/minimum 

velocity as well as the acceleration parameters.  

 

Figure 18 - Rotaflex Unit 

Rotaflex unit simulation requires the diameter of the sprockets, as well as the stroke length 

of the polished rod.  
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4.2. Surface Unit Inputs 
 

 

Figure 19 - Surface Unit Tab 

• Upstroke rate (per min): Stroke rate of the polished rod in SPM, when Use 

Different Speed for Upstroke/Downstroke checkbox is selected, different stroke 

rates can be specified for upstroke and downstroke 

• Stroke Length (in): If both Calculate From Surface Unit Geometry checkbox and  

Import Rod Position From File checkbox is unselected, a pure sinusoidal rod 

motion is assumed 

• Calculate From Surface Unit Geometry: Check this box if the type of unit and its 

dimensions are known 

• Import Polished Rod Position File: Available when Calculate From Surface Unit 

Geometry checkbox is unchecked, allowing the user to import a file defining the 

position of the polished rod verses time. Format of this file is specified in Section 4.3.4 

• Sampling Frequency: Time increment between the data points in the rod position 

file. This input is only available when Import Polished Rod Position File is selected  

• Database: Click on this button to open the excel file which contains unit information 

• Select Unit: Click on any unit in the dropdown list and import the unit dimensions 

into fields on the left-hand side 

• Unit Name is used to identify the unit. Can be changed by the user.  
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The Excel file, PumpUnitDesignation.xlsx, contains the default pumping unit database. A 

user can modify this file to add more units to the database. Newly added units must follow 

the existing format and unit parameters should be provided under the correct sheet in the 

workbook with parameter values under the correct column. The table below shows the 

required parameter for each type of unit. 

 

The first row of the database consists of column headers, designating a particular 
variable, e.g., Unit means the name of the unit. 
 
Every Beam Balanced Unit must have the following variables: 

• A 
• C 
• P 
• I 
• G 
• H 
• R1 (If a unit has only one crankshaft hole, specify its radius under R1. If there are 

multiple holes, specify each radius under R1, R2, R3... respectively) 
 

Additional Variables needed for conventional units 
• SU 

 
Additional Variables needed for Reverse Mark/Torque Master units 

• SU 
• Tau 

 
Additional Variables needed for Mark II units 

• SU 
• Tau 

 
Additional Variables needed for Air Balanced Units 

• M 
• S 

 
Rotaflex Units should contain 

• Sprocket diameter 
• Stroke Length 
• Maximum Stroke Rate 
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4.3. Surface Unit Information 

4.3.1. Beam Balanced Units 

 

Figure 20 - Beam Balanced Unit Information Panel 

• A, C, I, P, R: Unit Dimensions as defined in the diagram  

• K:  K = sqrt(I2+ (H-G)2), where H, I, G are Dimensions as defined in the diagram  

• Structural Unbalance: This is the variable SU in the database 

• Counter Weight Angle: This is the variable Tau in the database 

 
• Maximum Moment: Maximum counterweight moment on the crankshaft 

• Optimize Balance Moment: Obtain the optimal counterweight moment on the 

crankshaft to minimize the power requirement of the motor and the torque 

requirement of the gearbox 

• S: Pressure constant supplied by the manufacturer 

• M: Geometric constant supplied by the manufacturer 

• Pmax: Maximum pressure in the cylinder during operation 

• Pmin: Minimum pressure in the cylinder during operation 

• Mechanical Efficiency (%): Overall mechanical efficiency of the speed reducer and 

pumping unit, which affects the required motor horsepower 

• Calculated Stroke length: Calculated stroke length based on unit geometry 
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4.3.2. Hydraulic Units 

 

 Figure 21 - Hydraulic Unit Information Panel  

• Upstroke Maximum Speed: Maximum speed of the polished rod during upstroke 

under steady-state condition 

• Downstroke Maximum Speed:  Maximum speed of the polished rod during 

downstroke under steady state condition. Note that speed is always a positive value 

• Time Required To Accelerate From Rest To Upstroke Speed:  Amount of time 

required to accelerate the polished rod from rest to its maximum upstroke speed 

• Surface Stroke Length: The stroke length of the polished rod 

The diagram below illustrates the parameter required for hydraulic units 

 

Figure 22 - Hydraulic Unit Parameters 
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4.3.3. Rotaflex Units 
 

 

Figure 23 - Rotaflex Unit Information Tab 

• Sprocket Diameter: The diameter of the roller that moves the chain, as illustrated 

in Figure 18 

• Surface Stroke Length: Maximum displacement of the polished rod 

• Stroke Rate: Stroke per minute of the Rotaflex unit. Once a unit is selected from the 

database, this field will be filled with the maximum SPM possible (at steady state) 

for the given unit 

• Mechanical Efficiency: Overall mechanical efficiency of the speed reducer and 

pumping unit, which affects the required motor horsepower 

• Optimize Counterweight: Select to calculate the optimal amount of counterweight 

that will minimize the mean of net torque. 

• Counterweight: The counterweight for a Rotaflex unit is the sum of the weight box 

weight and auxiliary weight 
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4.3.4. Simulation without using surface unit geometries 

 

Figure 24 – Input required to simulate without Surface Unit Geometries 

STIPumpCard can simulate the dynamics of the sucker rod without knowing the surface unit 

geometry. There are two additional methods to define the motion of the polished rod if unit 

type or geometry is unknown.  

To use a sinusoidal approximation for the polished rod displacement vs. time, uncheck Calculate 

From Surface Unit Geometry checkbox and Import Rod Position From File checkbox. Enter 

surface stroke length and stroke rate(s). 

Alternatively, user can import the rod position data into STIPumpCard. First, uncheck Calculate 

From Surface Unit Geometry checkbox, and then check the Import Rod Position From File 

checkbox. Click on the Import Rod Position button to select the rod position file.  

The rod position file must be in *CSV format, if the Unit Preference  is set to SI, 

the unit for displacement must be in centimeters, if the Unit Preference is set to US, the unit for 

displacement must be in inches. An example file is shown below 

Time (Position Curve - No Filter),Position Curve - No Filter 
0,0 
1, 0.014588  
2, 0.096525 
3, 0.222895 
…. 

Figure 25 – Rod Position File Format 

Please note that the first column, which represent time, is not in seconds, but it is the sampling 

index.  
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5. Deviated Well Tab 
 

Use this tab when "Deviated Well" is selected in the Input Parameter - Simulation Setting 
- Simulation Mode. Survey information is required input for the deviated well simulation 
mode, and is specified in the "Survey" tab.  

Rod Guides are optional. STIPumpCard will recommend where the rod guides should be 
placed; the user can modify the recommendations by removing or changing the number of 
guides used. 

 

5.1. Survey Information 
 

 

Figure 26 – Survey Tab 

Dynamic Friction Coefficient - kinetic contact friction coefficient between bare rod and 

tubing. Should be less than the static friction coefficient 

Static Friction Coefficient – Used in the stick-slip (Stribeck) friction model implemented in 

STIPumpCard, which can occur in deep wells with high stroke length and low stroke rate. 

The Borehole profile file is a 3-column, comma-delimited text file, which specifies the 

depth and orientation of the borehole in standard drilling industry formats. Each column 



 

23 
 

represents the Measured Depth (MD), Inclination and Azimuth respectively. Inclination is 

defined as the angle that the borehole makes with the vertical. Therefore, a 0-degree 

inclination is vertical (downward pointing) and a 90-degree inclination is horizontal in 

direction. An angle greater than 90 degrees refers to “drilling up”. Azimuth is defined as 

having a value of 0 degrees for a North heading, 90 degrees for an East heading, 180 degrees 

for a South heading, and 270 degrees for a West heading. An example borehole profile file is 

shown in Figure 27. If metric units have been selected, the MD must be in ft and m must 

appear as the first entry in the 2nd row of the borehole profile. 

 

MD,INC,AZ 

ft,deg,deg 

0.00,0.00,0.00 

266,0.14,187.83 

327,0.31,257.33 

Figure 27 - Borehole Profile File Format 

Clicking the "Display Borehole Profile" button produce a 3D plot of the borehole profile. 

 

Figure 28 - Borehole Profile Plot Sample 
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5.2. Rod Guide Recommendation 

 

 

Figure 29 – Rod Guide Tab 

 

STIPumpCard can recommend where the rod guides are needed, based on the contact forces 

of the rod with the tubing. If the tubing is not anchored, additional rod guides will be 

recommended to prevent tubing buckling. 

Rod guide recommendations can be obtained by clicking the Update Recommended Rod 

Guide button. STIPumpCard will use the current user inputs, including survey profile, rod 

taper length/properties, fluid properties to create a table of recommended guides. 

Therefore, it is important to make sure that the rod guide recommendations are generated 

after all the other input parameters had been provided. 

On the left-hand side of the rod guide recommendation table, there is a list of parameters 

for generating a recommendation for rod guide placement.   

• Length of Individual Rods: The length of rods in each taper section, it can be specified 

using a single value, for example, 25, meaning that each rod in the rod string is 25 ft and 

that all tapers consist of rods of the same length. Alternatively, it can be specified using 

a list of numbers, for example, 25,30,25,25, representing the length of the rods in each 

taper section (from top to bottom). The number of elements in this list must be the 

same as the number of taper sections provided under the Input -> Rod Properties tab. 
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• Rod Guide Dynamic Friction Coefficient: Dynamic friction coefficient of rod guides, 

should be less than the static friction coefficient.  

• Rod Guide Static Friction Coefficient: Static friction coefficient of rod guides, 

determines the amount of force required to initiate motion.  

• Maximum Side Force Per Guide: The maximum force that each rod guide can sustain. If 

the sum of side forces (over all rod contact locations) on a rod section is 120 lb., and 

each guide has a maximum side force of 30 lb., then 4 guides will be recommended. 

• Minimum Side Load to Place Guide: The threshold force to place a rod guide. If the side 

load at any axial location along the rod exceeds this value, rod guides will be 

recommended. 

• Maximum Number of Guides per Section: Maximum number of guides in a rod section. 

The program will not recommend more guides even if the side load on each guide 

exceeds the Maximum Side Force Per Guide. 

• Minimum Number of Guides per Section: If the side load in a rod section exceeds the 

Minimum Side Load To Place Guide, then this minimum number of guides that can be 

placed. For example, if the minimum number of guides is 2, for the rods in which guides 

are required, at least 2 guides will be recommended. 

• Generate Rod Guide Recommendation When Running Program: When selected, 

STIPumpCard will recompute the rod guide locations when running the simulation. This 

could arise if, for example, the Minimum Side Load to Place Guide has been changed. 

• Simulate Without Rod Guide: When selected, simulation will use the bare rod friction 

coefficient throughout the rod string. 

 

 

Figure 30 – Rod Guide Plot Sample 

After the rod guide recommendation table is generated, a plot (Fig. 27) will pop up, showing 

the locations of the recommended guides. 
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6. Solver Parameter Tab 

 

Figure 31 - Solver Parameter Tab 

Simulation tolerance is set or modified through this tab. The default simulation type of “Fast 

Simulation” is adequate for most wells, however, if the result appears to be oscillating 

(showing wave-like patterns), a more accurate simulation may be obtained by reducing the 

tolerance. This can be done by selecting a Simulation type of “Accurate Simulation” or “User 

Defined Tolerance” and specifying a smaller value in the “Tolerance” textbox. 

Different ODE solvers may be suitable for different wells. If convergence issue arises, or if 

the computation takes too long to complete, it is advised to try a different ODE solver.  

User can also specify a different discretization length to obtain a finer mesh. With the 

mechanistic model that the STIPumpCard is using, the results are accurate even with 

relatively coarse meshes. 
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7. General Information Tab 
 

 

Figure 32 – General Information Tab 

Inputs in this tab are optional; they do not affect the numerical computation. User inputs 

from this tab will be written to the PDF report generated by STIPumpCard.  
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8. Output Tab 
Contains buttons to display output plots and tables. 

 

Figure 33 - Output Tab 
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8.1. Output Plots/Tables Groupbox 

 

Figure 34 - Available Output Plots and Tables 

• Rod Stress Distribution: Plot of rod stress vs. time and measured depth, as well as 

rod axial tension color-shaded map 

• Rod Axial Loading: Plot of minimum and maximum rod axial loads 

• Rod Fatigue: Color shaded plot of the rod with minimum fatigue life, and a plot 

showing the % Goodman Stress vs. depth of the rod 

• Dynamometer Cards: Plots of surface and plunger load vs. displacement. If a surface 

pumping unit has been specified, a permissible load, based on the minimum required 

torque rating is also shown 

• Velocity: Plot of polished rod and pump speed vs. displacement  

• Position: Plot of polished rod and pump position vs. time 

• Torque: Plot of torques (polished rod torque, counterbalance torque, and net 

torque) vs. angular displacement of the crankshaft 

• Side Forces: Plot of maximum side force vs. measured depth, as well as a table 

summarizing the side force for each section in the rod. This plot is only generated 

when the simulation is in the deviated mode 

• Result Summary: Table showing the result summary 

• Input Summary: Table showing the input summary 
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• Survey and DLS: Plot the survey profile as well as the Dogleg Severity vs. Measured 

Depth 

• Pump Load Analysis: Plot for "Pump load Analysis" Simulation mode, shows 

dynamometer cards determined from surface time/displacement/load data 

 

8.2. Output Parameters 
 

 

Figure 35 - Output Parameters 

• Rod Fatigue Life: Expected lifetime of the rod before failure 

• Motor Requirement: Minimum Required Name Plate HP of the Motor 

• Speed Reducer Torque Requirement: Minimum Required Speed Reducer Torque 

Rating, the permissible load is plotted on the dynamometer card based on this 

rating 

 

8.3. Output Files 
A subfolder named "Outputs_FiguresXXXX”, is created inside the project directory, 

where XXXX designates the project name to which all simulation output is written. 

In addition to the plots saved as PNG files is an Excel workbook called 

XXXXSimulationResults with seven worksheets named: 

1. Summary 

2. Load 

3. Displacement 

4. Pump speed 

5. Fatigue 

6. Rod Axial Loading 

7.  Torque 

 

STIPumpCard will also produce a PDF report after the simulation if Microsoft Office 

is installed. The name of the pdf is XXXXSummary.pdf; it contains a header which 

records the generation information of the project, a summary of input and output 

parameters, and some figures that the program outputs. 
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8.4. Sample Output  
 

 

Figure 36 - Rod Stress vs. Time 

 

Figure 37 - Axial Load on Rod 

Figure 36 shows the stress in the rod over the entire simulation. Figure 37 shows the 

maximum and minimum axial loads in the rod, where positive load indicates tension, and 

negative load indicates compression. 
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Figure 38 Fatigue life of Rod 

 

Figure 39 - Percent of Goodman Stress 

 

Figure 38 shows the fatigue life of the rod; this is the maximum operating time of the rod 

before fatigue failure. Figure 39 shows the percentage of Goodman stress in the rod. 



 

33 
 

 

Figure 40 - Torque vs. Angle 

 

Figure 41 - Dynamometer Cards 

 

Figure 40 shows the torques in the speed reducer; this plot is available only when the pump 

unit information is entered. Figure 41 shows the surface and downhole dynamometer cards. 
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Figure 42 - Speed vs. Position 

 

Figure 43 – Polished Rod and Pump Displacement 

 

Figure 42 shows the speed of the plunger and polished rod as a function of displacement. 

Figure 43 shows the position of the plunger and polished rod as a function of time. The 

black box highlights the current stroke. 
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Figure 44 - Side Force vs. Measured Depth 

 

Figure 45 – Dogleg Severity 

 

 

Figure 46 - Side Force Summary 
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Figure 47 – Wellbore Survey  

Figures 44 through 47 are only output for deviated wells. Figure 43 shows the side forces 

magnitude along the length of the rod. A table (Figure 46) is created to show the maximum 

and minimum side forces on each of the rod tapers. The red dots in the plots represent the 

recommended guide placement locations. Like other plots, this plot can be manipulated and 

since it is a 3D plot, it can also be rotated using the rotation tool as described in Section 11 

(working with Figures). 

 

 

Figure 48 - Pump Load Analysis Output 
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Figure 48 is output from "Pump Load Analysis" mode, in which the downhole card (shown 

in blue) is determined from the surface load card (shown in red). 

 

Figure 49 - Output Summary Table 

 

Figure 50 - Input Table 

Figure 49 shows a summary of output information. Figure 50 shows a summary of input 

parameters.  
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9. Tools Tab 

9.1. Unit Conversion 

 

Figure 51 - Unit Conversion Tab 

STIPumpCard provides a unit conversion tool that allows conversion between specified units. 
The input and output units must be consistent, for example, kg*m/s^2 is consistent with N 
but not consistent with J. 

All of the available units are shown in the table, and the user can combine any of the units 
using operators such as *, /, sqrt,(), ^ etc. 

Prefixes such as kilo or mega are treated as a dimensionless unit, a kiloN should be specified 
as kilo*N. 
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9.2. Density Calculator 

 

Figure 52 - Density Calculator Tab 

Allows conversion of liquid or gas density into specific gravity, as gas/oil specific gravity are 
required inputs to simulate vertical/deviated wells. Clicking Use This Value will copy the 
calculated specific gravity entry to the appropriate Input Parameters textbox. 

API Gravity is defined as below (G. Takacs, 2015, p. 15) 

API Gravity =  
141.5

Specific Gravity
 − 131.5 
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9.3. Intake Pressure Calculator 

Pump Intake Pressure can be calculated in two ways; either from IPR data or 
based on the dynamic fluid level in the annular region. 

 

9.3.1. Pump Intake Pressure from IPR Data 

 

Figure 53 - Intake Pressure Panel - From IPR  

 

Standard Inputs can be imported from input parameters 

• Pump Setting Depth: True Vertical Depth of the pump standing valve 

• Water Cut: Fraction of water with respect to total fluid volume (between 0 and 1) 

• Oil Density: Density of Oil can be specified with API degrees, specific 

gravity or density 

• Water Density: Density of water can be specified as specific gravity or density 

 
Data from Measurement 

• Test Pressure: The known dynamic pressure based on test data and can be 

at the pump intake or the bottom hole (Mid-Perforation Depth) 

• Test Fluid Production: Liquid flow rate from the well at the given test pressure 

• Measured At: Select where the test pressure is measured at 
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Additional Parameters for IPR calculation 

• Static Bottomhole Pressure: Pressure measured at the bottom hole 

(Mid- Perforation Depth) with no liquid flow out of the well 

• Bubble Point Pressure: At the given Fluid Temperature, this is the pressure 

at which gas starts coming out of the solution. Above this pressure, there 

will be no free gas present in the solution 

• Target Production Rate: As the required production rate is increased, 
pump intake pressure is reduced 

• Mid-Perforation Depth: The mid-depth of the perforations 
 

This pump intake pressure calculator is based on Vogel's Correlation (G. Takacs, 2015, p. 
46-50) 

9.3.2. Pump Intake From Fluid Level 

 

Figure 54 - Intake Pressure Panel - From Fluid Level  

Standard Inputs can be imported from input parameters 

• Pump Setting Depth: True Vertical Depth of the pump standing valve 

• Annular Gas Density At Standard Condition: Density of the gas column in 

the casing at standard temperature and pressure (1 atm, 70 deg F) 

• Annular Fluid Density: Density of fluid in the casing, for most of the wells. 
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Because oil has a lower specific gravity than water, it can be assumed that 

the annular fluid consists entirely of oil. 

• Fluid Temperature: Temperature of the well fluid 

 
Additional Parameters for PIP calculation from Fluid Level 

• Casing Pressure: Casing pressure at the surface 

• Annular Liquid Level: Dynamic liquid level of the well under production, therefore 
the calculated pump intake pressure is only valid at this rate of production 

• Liquid Fraction of Gaseous Liquid: Percentage of liquid of the gaseous liquid 
column in the annulus. The user can manually input this parameter or calculate 
this parameter using the calculator on the right-hand side. 

 
Liquid Fraction of Gaseous Liquid Calculator 

• Casing ID: Inner diameter of the casing  

• Tubing OD: Outer diameter of the tubing 

• Gas Rate: Rate of gas flowing out of annulus in Mcf/D (thousand cubic feet per 
day) 

Liquid Fraction of Gaseous Liquid Calculator is based on McCoy Correlation; it is 
accurate for wells with similar condition as the wells in Permian Basin of Texas and 
New Mexico. For wells outside of this condition such as heavy wells, this correlation 
underestimate liquid fraction by about 10% 

 

 

Pump Intake From Fluid Level calculator uses the static pressure (P = ρgh) in 
the casing to obtain the pump intake pressure. (G. Takacs, 2015, p. 362) 



 

43 
 

9.4. Stroke Rate Calculator 

 

Figure 55 - Stroke Rate Calculation Panel 

Stroke Rate Calculator estimates the Stroke Rate based on a desired target production rate. 
Populate Form With Values From Input Parameters button can be used to import existing 
input parameters from the input tab. 

Rod Dimensions and Properties must be imported from the Input tab, under the Rod 
Properties section. 

Production rate is estimated by estimating pump displacement first. Pump displacement is 
calculated via the equation below (G. Takacs, 2015, p. 255-257)  

Sp  =  Ss +  e0 − er − et 

where Sp , Ss is pump and surface stroke length, er, et is rod and tubing static stretch, e0 is 

plunger over travel. 
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9.5. Free Gas Calculator 

 

Figure 56 - Free Gas Calculation Panel 

Provides a way to estimate the amount of free gas present at the pump intake with or without 
gas anchoring.  

• Pump Intake Pressure: Pressure at the pump intake 
• Fluid Production Rate: This variable affects the effectiveness of gas separation. The 

higher the volume of fluid produced, the less effective the gas separator becomes. 
 

Additional inputs are required depending on whether there is a gas anchor. Below is a list of 
additional inputs required to estimate the free gas fraction of a well with a gas anchor 

 

Figure 57 -Additional Inputs Required For Wells With Gas Anchor 
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• Gas Anchor Type:  Specify the type of gas anchor  
• Down Flow Cross Sectional Area In Separator: Based on the geometry of the gas 

anchor, it is the average cross-sectional area through which liquid is flowing down  
• Separator OD:  Outer diameter of the annulus flow region of the separator, as shown 

in Figure 58. 
• Separator ID:  Inner diameter of the annulus flow region of the separator, as shown 

in Figure 58. 
• Bypass Pipe OD:  Outer diameter of the bypass pipe, as shown in Figure 58. This is 

only available for packer type separators. 
• Calculate Cross-Sectional Area From Separator Dimensions: When selected, 

Compute cross-sectional area using separator dimensions, including Separator ID, 
Separator OD and optionally Bypass Pipe OD. 
 

 

Figure 58 - Packer Type Separator Schematic 

 

Figure 59 -Additional Inputs Required For Wells Without Gas Anchor 

To import input directly from the input parameter tab, click on Populate Form With 
Values From Input Parameters button. 
 

• Production Gas Liquid Ratio (GLR): The ratio of gas to liquid in the well, in 
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standard cubic feet per standard barrel (scf/STB). It is a fluid   property, 

which does not depend on well pressure. 

 

For wells with a gas anchor, the free gas fraction is estimated using the Clegg 
correlation. It is recommended for the user to calculate the free gas fraction with and 
without a gas anchor (G. Takacs, 2015, p. 110-125). If the computed free gas fraction is 
higher with a gas anchor than without one, it indicates that a gas anchor is unnecessary. 
 
Consider the example below: 

 

Figure 60 -Free Gas Fraction Calculation Example 

 
In the example shown above (Figure 60), the estimated free gas fraction is higher 
with a gas anchor than without it, suggesting that a gas anchor should not be used, 
which in this case is due to a low production GLR ratio. 
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9.6. Damping Factor Calculator 

 

Figure 61 - Damping Factor Calculation Panel 

Provides a way to estimate the damping factor, which is based on polished rod speed. Uses 
an empirical correlation proposed by Sam Gavin Gibbs (G. Takacs, 2015, p. 288). The inputs 
are: 

• Surface Stroke Length  
• Stroke Rate 
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9.7. Pump Efficiency Calculator 

 

Figure 62 - Pump Efficiency Calculation Panel 

 
Provides a way to estimate pump volumetric efficiency. Most of the inputs to this calculator 
can be directly imported from input parameters. Rod Dimensions and Properties must be 
filled in from the Input tab, under the Rod Properties section.  
 
To import input directly from the input parameter tab, click on Populate Form With Values 
From Input Parameters button. 
 
Three additional inputs are required for pump efficiency estimation: 

• Clearance: The clearance between the plunger and tubing 
• Fluid Viscosity: Dynamic viscosity of the fluid 
• Plunger Length: The length of the plunger 

 
Pump efficiency is estimated based on the pump production and slippage lost. Slippage lost 
can be estimated with the Patterson Correlation (G. Takacs, 2015, p. 315) 

qs =  453(1 + 0.14N)
d∆p∆d1.52

μL
 

Where qs is the slippage per day, N is the stroke rate, d is the plunger clearance, ∆d is the 
plunger length, ∆p is the pressure differential across the plunger, μ is the liquid viscosity, and 
L is plunger length. 
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9.8. Buckling Calculator 

 

Figure 63 - Buckling Calculator Panel 

 
Provides a way to estimate buckling load. Most of the input to this calculator can be directly 
imported from input parameters.  
 
To import input directly from the input parameter tab, click on Populate Form With Values 
From Input Parameters button. 
 
Four additional inputs are required for buckling load estimation: 

• Clearance: The clearance between the plunger and tubing 
• Fluid Viscosity: Dynamic viscosity of the fluid 
• Plunger Length: The length of the plunger 
• TV ID: Inner diameter of the traveling valve 

 
The equation below is used to estimate drag force due to viscous fluid at the bottom of the 
rod (C. Eritici, 2016, p. 18) 

 
Where L is the plunger length, Db is the barrel ID, Dp is plunger diameter, μ  is the fluid 
viscosity, q is the fluid rate 
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9.9. Fluid Compressibility Calculator 

 

The Fluid Compressibility Calculator estimates the compressibility of fluid in the tubing 
under full pump condition (free gas = 0). Oil density can be specified using the its API number 
or specific gravity. The calculator assumes that the average pressure in the fluid is 1500 PSI.  
 
The equivalent compressibility used in the program is calculated internally using the user 
specified compressibility index and the tubing inner/outer diameters, with the assumption 
that the tubing is made of steel, with a Young’s modulus of 30*10^6 PSI. 
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10. Batch Processing 

 

Figure 64 - Batch Processing Panel 

 
 
Allows multiple simulations to be run sequentially in batch mode, where the output is saved 
automatically. The batch processing feature is especially useful for long runs, such as for 
deviated wells.  
 
After all the necessary input parameters are specified, a project can be saved into a project 
file (Go to Manu bar, File → Save or Save As). To batch process a number of saved projects, 
go to this tab, and then select the previously saved projects (mat files), using the Select 
Project Files button. If a file is selected by mistake, it can be removed from the batch list, via 
the Remove Selected button. Once all files are selected, start the batch run with the Start 
Batch Processing button. 
 
As each run is processed, a message in the log section indicates whether the run was 
successful or if an error occurred during the simulation. After the simulation, the results are 
automatically saved to the results folder and to the project file. The output can be viewed by 
opening these projects. 
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11. Working with figures 

Plots produced by STIPumpCard is interactive, they can be zoomed in/out, labeled, and 
rotated. Take the following plot as an example: 
 
 
 
 

 

 

Figure 65 – Interactive figure produced by STIPumpCard 

 

Figure 66 – Illustration of the brushing tool and the data labeling tool 

As shown in the figure above, points can be highlighted using the brush tool . Actions 

associated with a tool can be accessed by right-clicking after tool selection. Upon right-clicking 

after selecting the brush tool, a user can interactively mark, delete, modify, or save data points 

in plots, as shown by below 

Open an existing 

figure 

Save the figure 

Print the figure 

Delete/insert Legend Brush to 

highlight data 

Label Data 

Point 

Pan plot 
Zoom In, 

Zoom Out, 

and Restore 
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The data associated with the points can also be copied to the clipboard and pasted into another 

application, such as Excel or a text editor. The coordinates of any point on the plot, can be 

displayed using the data labeling tool . Right-clicking brings up a series of options, such as 

formatting of the data tip as well as the creation of multiple data tips, which can be used to 

mark salient areas of a plot. 
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Figure 67 – Rotation capability for 3D survey plots 

For 3D survey plots, the survey can be rotated interactively using the rotation tool . If an 
orthogonal view is desired, user can right click anywhere on the figure and select X-Y/X-Z/Y-
Z view as shown in the options below 
 

 
 

 

  

Rotation Tool 
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